
Installing	and	running	Brusherator	Photoshop	extension.

Note	that	this	software	will	only	run	in	Photoshop	CC	and	newer.	
CS6	and	below	aren’t	supported.

1.	 Installing
A.	 Native	Installers:	All	Photoshops.

Note	that	because	I'm	not	an	identified	developer,	Mac,	Windows	or	AntiVirus	software	will	be
suggesting	to	not	use	these	installers.	If	you're	not	comfortable	with	ignoring	your	OS	advice,
please	use	a	different	installation	method.
Use	/Install	Windows/Install_Brusherator_1.8.0.exe	if	you're	on	Windows.
If	you	have	Avast	antivirus	you	can	get	ShellExecuteEx	299	error ,	ignore	it	¯\_(ツ)_/¯

Use	/Install	Mac/Install_Brusherator_1.8.0.pkg	if	you're	on	Mac.
To	open	the	.pkg	from	unidentified	developer,	do	this

Restart	PS	if	it's	running.
B.	 ZXP	Installer:	Photoshop	CC2015,	CC2017+.

Goto	ZXPInstaller,	download	ZXPinstaller	for	Win	or	Mac	and	drag-n-drop
/ZXP/Brusherator_1.8.0.zxp	to	ZXPinstaller	window,	restart	PS.
Why	do	you	need	use	3rd	party	software?	Adobe	discontinued	Extension	Manager	after	CC2014
and	currently	there’s	no	official	way	to	install	extensions	for	modern	Photoshops.

C.	 Adobe	Extension	Manager:	Photoshop	CC,	CC2014.
Find	Adobe	Extension	Manager:
On	Windows:	C:\Program	Files\Adobe\Adobe	Extension	Manager	CC\
On	Mac:	/Applications/Adobe	Extension	Manager	CC/

Or	download	it	from	http://www.adobe.com/exchange/em_download/
Goto	File	>	Install	Extension	and	browse	for	/ZXP/Brusherator_1.8.0.zxp.

D.	 Manual	installation	(if	nothing	worked).
Navigate	to	/Manual	Install/
Unzip	Brusherator_1.8.0	files.zip	to
On	Windows:	C:\Users\**USER**\AppData\Roaming\Adobe\CEP\extensions\	
(to	get	there	paste	%appdata%	to	file	browser	and	hit	Enter)
On	Mac:	/Library/Application	Support/Adobe/CEP/extensions/

If	the	directories	aren’t	there,	create	them
Copy	the	scripts	from	/Scripts/	file	to	**Photoshop	folder**/Presets/Scripts	(optional).
Copy	the	com.kritskiy.historator	folder	from	the	Manual	Install	folder	to
On	Windows:	C:\Users\**USER**\AppData\Roaming\
On	Mac:	/Library/Application	Support/

2.	 Running
Run	from	Window	→	Extensions	→	Brusherator
What	is	Brusherator	Plus?	It’s	a	second	Brusherator:	they	share	the	same	tools	shelves	but	have
their	own	settings.	For	example	you	can	have	common	tools	on	one	panel,	less	common,	actions
or	specific	instruments	on	a	second	one.

3.	 Using
There’s	a	manual	available
Questions/problems?	Drop	me	a	message	kritskiy.sergey@gmail.com
Find	more	tools	on	my	Gumroad	or	Cubebrush

https://support.apple.com/kb/PH25088?locale=en_US
https://www.zxpinstaller.com
http://www.adobe.com/exchange/em_download/
http://brusherator-manual.readthedocs.io/en/latest/
mailto:kritskiy.sergey@gmail.com
https://gumroad.com/kritskiy
https://cubebrush.co/kritskiy/


Version	history

15	Dec	2019:	Brusherator	1.8.0
	Tags	and	Tags	Manager	for	buttons;
	Option	to	Sselect	from	Groups	when	adding	Brush	Presets;
	New	setting:	Show	Buttons	Tooltips;
	Brusherator	History:	new	Tool	Override	setting;
	Changed:	Actions	are	no	longer	exported	with	a	shelf:	this	was	causing	freezes	for	some	cases.	Actions

should	be	exported	manually	now.
	Some	missing	tools	and	menu	items	were	added	to	``Add	from	Menu	items``	section	(Curvature	Pen,	Select

Object);
	Bugfixes;

19	Dec	2019:	Brusherator	1.7.2
	New	Temporary	Tool	button	in	the	bottom	menu
	Installers	updated	to	support	Photoshop	2020;
	Fixed:	unability	to	set	hotkeys	to	specific	keys	using	the	Assign	Shortcut	command;
	Fixed:	if	scripts	for	assigning	shortcuts	are	missing	Brusherator	will	show	an	error	message;

15	Aug	2019:	Brusherator	1.7.1
	Fixed:	Brusherator	History	scripts	were	unassignable	via	the	panel	interface

14	Aug	2019:	Brusherator	1.7.0
	It's	possible	to	change	Data	Folder	location	to	a	different	folder	(i.e.	for	syncing)	using	the	Open	Data	Folder

Options...	command	from	the	fLyout	Menu
	New	Mute	Panel	Colors	setting	and	script	to	toggle	panel	buttons	background	color	on	and	off
	You	can	sort	Brusherator	History	list	by	dragging	the	items
	Number	of	assignable	slots	on	Brusherator	History	was	increased	to	10
	Scripts	that	aren't	part	of	Toggletator	and	Scriptorator	have	a	Reveal	Location	button	in	the	Edit	Button

window
	Fixed:	Using	the	Select	previous/next	brush	functions	(,/.	keys	by	default)	was	resulting	in	empty	items	in

Brusherator	History

19	Jun	2019:	Brusherator	1.6.0
	Export	all	shelves	in	one	go	from	Manage	Shelves	window
	New	``Preserve	Brush	Settings``	setting:	preserve	opacity,	flow,	blending	mode,	wetness,	strength	when

selecting	brush	or	tool	presets	with	Shift	key	(CC2015.5+)
	Assing	hotkeys	to	Select	Alternative,	Cycle	Tools,	Toggle	BT/BTP/BTP2	Panels	directly	from	Brusherator

panel	(from	the	flyout	menu)
	Fixed:	When	an	action	UI	window	is	cancelled,	error	message	appearing
	Fixed:	Too	many	folders	inside	the	Scripts	folder	crashing	PS
	Fixed:	Too	many	buttons	in	the	same	time	ctashing	Brusherator

21	May	2019:	Brusherator	1.5.3
	Fixed:	adding	Actions	and	Scripts	was	broken	in	some	cases
	Fixed:	Adding	many	buttons	in	the	same	time	breaking	the	panel

17	May	2019:	Brusherator	1.5.2
	When	adding	new	Brush	Preset	from	the	active	tool	it's	possible	to	Capture	Tool	so	it'd	act	as	a	tool	preset

(CC2018	and	newer)
	Fixed:	included	scripts	not	working
	Fixed:	UI	clashing	in	Add	New	Button	window

2	May	2019:	Brusherator	1.5.1
	New	option	when	adding	buttons:	Create	Preview	(off	by	default),	allows	to	create	buttons	faster.	You	can

create	the	previews	later	from	Edit	Button	window	or	from	RMB	menu	in	Edit	Mode
	It's	possible	to	set	names	for	several	selected	buttons	in	Add	Button	dialog
	Fixed:	weird	horizontal	line	on	top	when	only	one	shelf	is	available	and	"show	shelves	as	tabs"	turned	on
	Fixed:	certain	scripts	not	working	when	placed	on	Brusherator
	Fixed:	minimum	size	for	Brusherator	History	has	been	reduced	to	50px

4	Mar	2019:	Brusherator	1.5.0
	+	Add	brushes	and	tools	by	clicking	on	them:	Add	from	History	was	transformed	to	Add	from	History	or

selected;
	Add	Menu	Items	command	now	includes	commands	from	flyout	menus
	It's	possible	to	match	width	and	height	of	a	reference	button	in	one	action
	Better	integration	with	Toggletator	and	Scriptorator:	Ctrl/Cmd+Click	on	a	script	button	doesn't	try	to	look	for

https://toggletator-manual.readthedocs.io/en/latest/
https://scriptorator.readthedocs.io/en/latest/index.html


an	alternative	for	a	script,	it's	possible	to	open	Scripts	Settings	directly	from	Edit	Button	and	flyout
menus

	New	Item	Title	field	when	creating	and	editing	buttons	for	custom	buttons	titles
	fixed	Export	and	Import	shelf	issues
	fixed	bottom	settings	menu	not	working
	fixed	Save	menu	command	working	as	Save	As
	fixed	Layer	>	Background	menu	command	not	working	properly

4	Sep	2018:	Brusherator	1.4.1
	new	Add	from	History	favourites	option	for	adding	buttons
	Labels	can	be	not	only	text,	but	also	thumbnails
	third	Brusherador	panel:	Brusherator	Plus	2
	Performance	improvements
	Selected	tool	is	visible	on	Brusherator	History
	option	to	remove	Alternative	in	the	Edit	Button	window
	History	not	available	in	Photoshop	CC2015
	Wrong	placement	of	thumbnail	button	names	fixed
	Various	small	fixes

9	Aug	2018:	Brusherator	1.4.0
	️New	panel:	Brusherator	History	(CC2015+)
	️New	item	type:	text	label
	️New	item	type:	menu	item
	️Text	buttons	can	be	resized
	️Shelves	can	be	sorted	manually

	Performance	improvements
	Better	buttons	rendering
	Sample	shelf	updated	with	1.4	features

	various	fixes

25	Oct	2017:	Brusherator	1.3.5
	Fixed	Delete	and	Export	for	Brush	Presets	in	CC2018
	Fixed	inability	to	change	Previewrator	panel	size	in	PS	CC2018
	Fixed	toggle_alternative	script	not	working	with	Brush	Presets
	Fixed	"\"	symbol	in	shelf	name	causing	troubles

18	Oct	2017:	Brusherator	1.3.4
	Fixed	inability	to	change	panel	size	in	PS	CC2018
	Fixed	rare	freezes	on	Win10
	Scripts	from	symbolic	links	inside	PS	Scripts	folder	are	imported	correctly
	I	fixed	something	in	bt_cycle	script	but	I	don't	remember	what
	Installer	installs	additional	scripts	to	CC2018	folder

25	May	2017:	Brusherator	1.3.3
	Fixed	an	error	with	localised	PS	versions

24	May	2017:	Brusherator	1.3.2
	New	documentation
	Panel	settings	are	stored	in	Photoshop	rather	in	Web	Storage	(this	will	reset	current	settings	on	first	launch)
	Resize	handler	active	area	is	smaller	now,	easier	to	move	small	buttons	in	Edit	Mode
	bt_cycleTool	will	respect	Preserve	Brush	Size	option
	BT_	and	BTP_	shelf	switchers	will	reveal	the	panel	if	it	was	hidden	and	won't	reload	the	panel	if	they're

activating	the	active	shelf	(please	recreate	your	switchers	with	the	updated	BT_brushes.jsx)
	Got	rid	of	tool	tips	on	buttons

	No	more	scrollbars	when	tabs	are	visible
	Resize	to	Content	option	respects	tabs	(in	most	cases)
	Fixed	Transfer	Buttons	for	PS	CC	2013
	Fixed	bt_cycleTool	for	PS	CC	2013
	Buttons	are	created	in	correct	coordinates	in	Tabbed	mode
	Current	Thumb	option	from	Edit	Button	doesn't	require	an	opened	document
	Some	other	minor	fixes

17	Apr	2017:	Brusherator	1.3.1



	️Tooltips	for	all	functions
	️Tooltips	on	buttons	will	show	the	name	of	the	preset	they're	linked	to
	️Scripts	in	Alias	folders	will	appear	in	Select	Scripts	windows
	️Scrollbars	are	in	the	color	of	Photoshop	UI	and	smaller

	Fixed	some	crashings	on	Windows	10
	Sample	panel	only	loads	from	Brusherator,	not	Brusherator	Plus
	No	more	persistent	scrollbar	when	Show	Shelves	is	enabled

28	Mar	2017:	Brusherator	+	BrusheratorPlus	1.3.0
	️Sample	shelf	for	first-time	users
	️Scripts	may	be	added	on	the	panel	as	buttons
	️Export/Import	Shelves
	️Delete	several	(selected)	buttons	in	one	go
	️Add	a	button	from	last	used	preset
	️Cycle	between	two	last	used	buttons	(with	bt_cycleTools)
	️Holding	SHIFT	while	hitting	"add	from	active	tool"	will	create	a	new	button	using	the	last	used	settings
	️Bottom-right	menu	disappears	if	the	panel	size	is	too	small
	️Set	background	color	for	auto-thumbnails
	️Create/update	alternative	presets	directly	from	Edit	Button	window
	️Marquee	select	several	buttons
	️Align/stack	buttons,	match	their	size	and	background	color
	️Option	to	auto-resize	Brusherator	to	panel	content	(CC2015	and	above)

	Bottom-right	menu	remembers	its	state
	Alternative	tools	can	use	both	prefix	"a_"	and	suffix	"_a"
	Buttons	with	missing	tools	marked	with	red	overlay	
	Buttons	with	missing	thumbnails	marked	with	red	cross
	GUI	support	all	4	colors	of	the	Photoshop	UI	color
	Better	icons	for	light	verision,	icons	are	SVG	now
	All	Brusherator	scripts	are	now	in	separate	category

	BT	is	more	prone	to	weird	shelf	names
	Warnings	for	presets	with	emoji	symbols	(they'll	cause	errors)	
	No	more	weird	behaviour	of	buttons	with	negative	coordinates
	No	more	buttons	stacking	upon	each	other	(buttons	made	in	the	same	coordinates	will	spread	out	after

panel	reload)
	Buttons	always	respect	the	grid
	Fixed	weird	text	rendering	on	Windows	for	text	buttons
	Errors	in	shelf	files	won't	cause	the	panel	to	break
	ExternalObject	error

05	Dec	2016:	Brusherator	1.2.1
	Panel	persistence	is	turned	on

05	Dec	2016:	Brusherator	1.2.0
	️Brusherator	Plus:	a	second	panel	for	more	tools!
	️Move	several	buttons	at	once
	️Copy	or	move	brushes	between	shelves
	️Option	to	show	shelves	as	tabs
	️Create	new	tool	and	brush	presets	directly	from	Brusherator
	️Rename	and	duplicate	shelves
	️Update	current	preset	from	Flyout	menu
	️More	scripts	for	power	users

	️New	buttons	are	added	under	the	cursor	(when	added	from	RMB	menu/hotkey)

	️Flyout	menu	of	other	extensions	won't	create	shelves	on	Brusherator	(whaaat)
	️No	more	empty	lines	in	shelves
	️No	need	to	switch	off	Current	Tool	Only	Photoshop	option	anymore
	️Wrong	names	of	context	menu	items

16	Nov	2016:	Brusherator	1.1.0
	Actions	may	be	placed	on	a	panel	as	buttons
	Flyout	menu	(CC2014+)	—	striped	small	thing	on	the	right	of	the	panel
	You	can	select	shelves	from	flyout	menu



	Option	to	toggle	brush	size	inheritance	for	all	buttons	(default:	size	is	inherited)
	Option	to	toggle	names	visible	on	image	buttons	(default:	off)
	Option	to	close	a	panel	after	button	click	(default:	off)
	Name	filter	field	in	"Select	Preset(s)"	dialog	is	available	on	CC2015+	on	OSX	(may	be	slow!)
	You	can	open	Brusherator	data	folder	from	flyout	menu	(for	backups)

	️Brush	selection	is	faster	on	Windows
	️"Name	on	the	panel	"	field	is	available	for	all	types	of	buttons	(so	you	could	type	a	name	for	image	button)
	️"Use	preset	size	"	checkbox	if	you	want	to	override	brush	size	inheritance	for	specific	tool
	️"Select	Preset(s)"	dialog	is	taller
	️Checker	for	Current	shelf

	️Button	size	ignores	Photoshop	UI	font	size	option
	️Moving/resizing	buttons	in	Edit	Mode	won't	trigger	them
	️Tablet	Pen	doesn't	lose	sensitivity	in	Windows

11	Nov	2016:	Brusherator	1.0.1
	Wrong	thumbnails	size	when	Photoshop	rulers	aren’t	pixels
	Text	buttons	with	spaces	in	their	names	jumping	all	over	the	place

10	Nov	2016:	Brusherator	1.0
10	Nov	2016:	Brusherator	Preview	1.0


